
Imagine the main functions of Adobe’s creative suite
rolled into a single integrated application!

Adobe won’t do it, but ACD Systems already has...

IMAGE CREATION, MANIPUL ATION & EDUC ATION
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Using ACD Canvas, you can easily create

photorealistic illustrations that combine image- and

vector-based objects. The Egyptian themed illustration on

this issue’s cover was created using vector shapes and one image.

I started by scanning the back of a papyrus painting for the

background texture; some objects from the painting itself make up the

graphic elements at the top. Next, I created a square with the Rectangle

tool and filled it with a white, yellow and orange gradient to simulate a sunrise.

I applied Directional Transparency to the “sunrise” to gently blend it into the

papyrus background.

Next I chose one of Canvas’ EasyShapes (a pre-made triangle outline) to

represent a pyramid and filled it with a red/brown gradient. I

applied the Jiggle filter in Alien Skin Eye Candy 4000 as a

SpriteEffect to roughen up the edges of the

pyramid. (SpriteEffects are Canvas’ way of

applying imaging filters to vector objects).

Finally, I added Noise to

complete the Egyptian

d e s e r t

weathering

effect.

behind the cover art

The finished pyramid was duplicated twice and slightly

altered for variety and size and to achieve perspective

and fit. Since the sun is the main light source in this illustration, I had to add some

shadows. I duplicated (Edit>Duplicate) each pyramid and chose

Effects>Flip>Vertical. This duplicate was moved into place below each original.

I used Effects>Envelope>Distort and dragged the bounding handles as necessary to

create a realistic shadow angle. The shadow objects were filled with varying depths of

gradients to imitate atmospheric haze and lighting variation.

To make the burning red sand in the foreground was a simple task. A rectangle was filled

with a reddish gradient upon which Noise was added. Finally, the Lens Flare effect was

applied on a black rectangle that covered the entire layout. I chose the Screen transfer

mode to drop everything but the flare from visibility, resulting in the final touch of photo-

reality to the scene.

Perhaps you noticed the strange

hieroglyphics at the right of the image. I

mixed in some Canvas tool icons and more

EasyShapes for a humorous touch.

On the next page you’ll see more Canvas

bitmap/vector combo tricks.•

If you’d like to experiment with an

original version of this and many other Canvas

illustrations created for The Canvangelist Canvas ezine, please

see www.plugsandpixels.com/canvangelist/dvd.html for more information

about “The Canvangelist Collection” DVD (includes stock photos).

http://www.plugsandpixels.com/canvangelist/dvd.html


Overlay mode

Difference mode

Lighten mode
Hard light
mode

Place a vector rectangle filled
with a color gradient over the

image and align. Apply the
blending mode effects to the

rectangle only. The creative
potential is endless!

Original image

ACD Canvas seamlessly and effortlessly handles a combination of

both vector and image objects. The fun begins when you combine

the two together with blending modes and render the end result.



On the last two pages you’ve seen how Canvas allows a combination of image and vector objects in the same

document, with transparency supported on all objects. This is sort of like having a marriage of Photoshop and Illustrator

in one application, with the added benefit of page layout capabilities (this ezine is laid out in Canvas!), not to mention

web and PDF export. And the price is much lower than you would expect (between $350-400).

This flexibility remains unmatched in the graphics industry, where it remains common to launch two, three or even four

separate applications to produce a brochure or website. Granted, these graphics suites offer inter-compatibility among

the related programs, but that’s a lot of overhead! In Canvas, you stay where you are, working on single or multiple pages,

and let your imagination run free without artificial barriers. Of course you can pull in content from other applications – I

routinely drag and drop images from Photoshop into my Canvas layouts for publication in this ezine – and export to other

apps as well. Thus Canvas can be your desert island application or your graphics hub.

The fun illustration on this page was created entirely in Canvas, WITHOUT any image-source

objects! To pull it off I began with Canvas’ various vector creation tools, creating each

item and adding gradient textures, Gaussian blur and noise to add

realism. Canvas’ Extrude function was used to make

the candles and burger components.

This illustration relies heavily on

Canvas’ Shadow effect feature,

which creates a separate image

object that can easily be adjusted to

suggest movement in the light

source of the artwork. All items are

tracked via an object list.

When the art is completed, all

of the objects can be rendered

into a hi-res image for publication

or electronic distribution.

The original editable Canvas-format

artwork file is available on The

Canvangelist Collection DVD

(see next page).



the
Canvangelist
Collection

-dvd-
www.plugsandpixels.com/

canvangelist/dvd.html

Over 1000 royalty-free stock photos

Over 50 original Canvas-format illustrations to explore

2009 printable calendar, ezines, tutorials and more

4.1 gigs on DVD-R for only $19.99

http://www.plugsandpixels.com/canvangelist/dvd.html


Traditional fine art

photographers who have

shot their images on silver-based

film for years, having highly refined

that technique, may be hesitant to

convert totally over to a new

digital imaging workflow.

Smoothing the path of this

transition is Silver Oxide. They

provide both black and white and

infrared emulsion simulation plug-

ins that do an excellent job of

mimicking the unique tonal

characteristics of film, as shown

here. Now digital photographers

never have to look back to film.

Not only can you

convert your

color images to

grayscale, but

you can choose

to apply any of

numerous film

emulsion types

to the final result.

I chose to render

the flowers with

a Tri-X effect. The

filtered photo of

the eyes was

masked with the

original color

image.

I shot thousands of rolls of

Kodak Tri-X film and made

thousands of black and white

glossy prints in the '70s through

'90s, so I find the Tri-X plug-in

especially interesting! The

results look just like a freshly

fixed paper print. Add a little

noise or grain effect and you'll

be hard pressed to tell the

difference.
Choose from many 8 and 16-bit film emulsions from Agfa,

Kodak and Ilford (see list at left)

Years ago you started with Black and White, because it

was cheap and because it let you put your hands on the

process. Along the way you discovered the power of the

media. When you shoot a subject in color, you photograph

their clothes, but

when you shoot in

Black and White, you

reveal their soul. To

reveal your vision,

there is SilverOxide.

www.plugsandpixels.com/silveroxide.html

http://www.plugsandpixels.com/silveroxide.html


Open an image.

Choose an action.

Click a button.

Get great results.

Fast!

Ultra Image.

Purchasing Ultra Image for Photoshop is the quickest

way to get commercial photographer Michael White to

climb inside your computer and do all of your heavy image

adjustment work for you! Ultra Image is a suite of numerous,

complex Actions written by White and designed for

improving digital camera images automatically.

The Stylized Color/Sepia effect applied to the image

above is the result of multiple calculations (see list in

screenshot at right) applied with literally no effort.

Other image enhancements applied via single or multiple

SuperSet Action sets include Color and Tonal range

adjustments, Noise reduction, Sharpening, Step

interpolation and output preparation (with image specs

set specifically for printing press or internet use).

Set the Actions to pause if you wish to intervene manually

at certain steps. After running the Actions, check the

History palette for a list of what was done – it's an image

retouching education in itself!

Stylized color sepia

www.plugsandpixels.com/ultraimage.html

http://www.plugsandpixels.com/ultraimage.html


Dfine 1.0 is a plug-in by nik multimedia that
addresses common ailments in straight-from-the-
camera digital images. Using installed custom
camera profiles (which you can purchase online),
Dfine repairs your images using a series of four
overall steps (the last three of which are illustrated
in the screenshots at right):

1) Review and Reduce Luminance Noise
2) Reduce Chrominance Noise & JPEG Artifacts
3) Adjust Color Cast & Color Balance
4) Adjust Contrast & Light
The example images on this page were opened in

Dfine just as they came straight from the camera (a
Canon EOS 10D, 200mm 1.8, ISO 800). Notice how
each of the the various Dfine procedures made
dramatic improvements to the unedited, original
images.

(Photos by Ted Wilson. Cats courtesy of Wild About Cats)

Chroma Noise & Artifacts options: Global Reduction,

Protected Reduction and JPEG Reprocessing

Color Cast & Balance options: Remove Blue Cast,

Adjust Saturation & Color, Subtractive Color Filter

Contrast & Light options: Highlights & Shadows,

Counter-Light Reduction, Tonal Adjustments.

www.plugsandpixels.com/dfine.html

http://www.tedwilsonphoto.com
http://www.wildaboutcats.org
http://www.plugsandpixels.com/dfine.html


Panopticum has rolled five of

its titles into one bundle: The

Photo FX plug-in collection. Alpha

Strip 1.110 (below) uses the image's

alpha channel to create geometrical image masks containing

lines, circles and rectangles. This effect is especially useful for

web and logo design. Digitalizer 1.0 (center left screen) is an

ASCII text character generator, reducing your image to a

matrix-like set of

characters of your

choosing. Engraver 1.0

(lower left) simulates

the look of a metal

engraving through use

of thin lines in a

geometric pattern.

Fire 3.0 creates an effective simulation of fiery tongues

with realistic lighting and shading (lower right). Lens Pro

3.0 is a lens effect generator, warping your images using

adjustable glass and crystal surfaces (center right screen;

top L & R).

www.plugsandpixels.com/photofx.html

http://www.plugsandpixels.com/photofx.html


Modules:
•Color Correct

•Bleach Bypass

•Low Contrast

•Flashing

•Overexpose

•Diffusion

•Blur

•Grad Grain

•Post Color

Correct

Throw away your camera filters, and while you're at it, ditch

your wet lab darkroom! They're all replaced with the Digital Film

Lab by Digital Film Tools of Los Angeles.

As you can see here, Digital Film Lab is capable of some radical

reinterpretations of your 8- or 16-bit images, using DFT's in-house

proprietary software packaged as a plug-in you can now own.

For the background image, I used the Post Color Correct module.

The blown-out image of the house below was created with

Overexposure, while the scenic image was made moody

by using the Gradient module.

www.plugsandpixels.com/digitalfilmlab.html

http://www.plugsandpixels.com/digitalfilmlab.html


Pictographics' iCorrect EditLab

helped me see my old Switzerland

photos in a whole new light! For

18 years since I shot it, the

mountain scene at bottom

(probably shot on some odd

brand of slide film) has had a nasty

yellow/green cast in the clouds. A

few seconds with iCorrect

(screenshot below) and blue skies

are here again! It took basically

one click.

Let's take a look at how this

treatment works.

There are four main tabs in the iCorrect

interface through which you progress

logically as you correct your image: 1)

Color balance (shown in the main

screenshot) is used to remove color casts

that affect the entire image. Click on

neutral values throughout the image and

let iCorrect adjust the values for you.

2) The black and white point selection

tab (upper right) actually alters the tonal

range, much like using Levels. You can

manually select the perfect black and

white areas of the image, use the histogram sliders as shown here, or use the SmartColor

auto option. 3) The Global brightness/contrast/saturation tab (center right) is used for

redistributing tones as needed. 4) Hue selective editing (right) works on user defined

hue regions while leaving others unaffected. Use the color ring to select the particular

hue you wish to edit.

So we've got four powerful options for auto or hands-on color correction!

www.plugsandpixels.com/icorrecteditlabpro.html

http://www.plugsandpixels.com/icorrecteditlabpro.html


The incredible Studio Artist artistic imaging

application, version 3, is packed with even more

power than previous versions. With over 3000 paint

presets and hundreds of other factory effects, chances

are you’ll never reach the bottom of what this unique

application can do to your still as well as video images.

Here’s a tipoff: The application ships with 3 full CDs of

QuickTime training videos. You’re going to want to

watch them all!

Although Studio Artist can

simulate natural media paint

effects, this is only part of its

appeal. Add hand-painted

effects to one frame of a

video and let Studio Artist

handle subsequent frames

automatically. Use the new

resolution independent

Vectorization option to

output artwork as EPS.

www.plugsandpixels.com/studioartist.html

http://www.plugsandpixels.com/studioartist.html


Evident Technologies, LLC of Austin, Texas has updated their entire range of

Asiva plug-ins to the 2.2 designation. Let's take a look at each one and see

what they can do for your image editing needs.

Asiva Sharpen+Soften is more than just a general sharpening and blurring

effects plug-in! Using the Hue, Saturation and Value Maps on the right of the

interface, you can achieve full control over each of these parameters,

applying treatment to separate aspects of the image. This is important since

sharpening and softening needs are usually uneven across an image, and

global Unsharp masking, for instance, is not always appropriate due to its

heavy-handedness.

You begin by choosing a color space in which to work (such as HSV, where

you can edit the Value channel independently), and which of the HSV

checkbox options will be enabled for editing. In my example, I chose to

blur selective colors in the vines image while leaving the rest untouched. The

result is an artistic interpretation of an otherwise merely “nice” photograph.

The precision editing capabilities of Sharpen+Soften are also very useful

for retouching portraits, where you would want to soften the skin tones but

leave normal detail in the eyes, lips and other edges.

Original

www.plugsandpixels.com/sharpensoften.html

http://www.plugsandpixels.com/sharpensoften.html


Asiva Shift+Gain can be used in two overall ways: First, the Shift

operation is useful for making color corrections, such as skillfully removing a

specific color cast in parts of the image, or causing a radical tonal shift for

creative purposes. My example shows the latter, as it is more effective in

this particular image.

I began creating the otherworldly effect below by sampling a long, thin

rectangle that included the entire tonal range of the blue sky color. My goal

was to shift this gradient range into a set of completely different hues. I

then made adjustments to the HSV sliders until I was satisfied with the new

color. Using the Preview options (selecting Overlay Color to fill in the

selection to be affected), I was able to confirm that only the sky pixels

were being affected, as opposed to the plants or hills.

Asiva Shift operations can also be used for filling in saturation that is

lacking in tonally brittle digitally captured images.

Second, the Gain aspect of Shift+Gain gives you control over the intensity

of the pixels in specific tonal ranges, the result being smoother transitions

among all values. You can target highlights for the gain operation while

leaving shadow areas untouched, thus bringing extremely contrasty lighting

under control.

Original

www.plugsandpixels.com/shiftgain.html

http://www.plugsandpixels.com/shiftgain.html


Asiva Correct+Apply Color is an advertiser's dream in that it enables a

designer to completely change the color of a product without the need to

reshoot the original image repeatedly. Or, as shown, you can change the

hue of a color-range selected portion of a standard image of any subject.

Start by drawing a rectangle that encompasses the highlights, midtones

and shadows of the color area you wish to change. The HSV dialogs

reflect the tonal range of your choice, and can be further tweaked as

necessary.

Choose a new color for your subject by clicking on the Target Color box

and picking from the color picker. I changed my flower from pink to blue,

reduced the blend amount, and thus retained the detail of the original.

Make further adjustments to the Saturation and Luminance Value sliders as

necessary to remove any of the original color that is still showing. Protect

yourself as you work (and also give yourself many options) by clicking the

Save button to store any potentially useful settings as a baseline to return

to and load later.

When editing portraits, you have the option of loading a desired flesh

tone color in place of the existing skin color by using the same procedure

as above, and by using the Blend Amount slider for fine tuning the mix of

original and altered skin color.

Original

www.plugsandpixels.com/correctapplycolor.html

http://www.plugsandpixels.com/correctapplycolor.html


So far we've seen how Asiva plug-ins can be used to isolate and treat the

specific tonal values found within an image right within their own interfaces.

Asiva Selection is concerned with using Hue, Saturation and Luminance

curves to make highly targeted selections that can be displayed and further

edited in the host application (as opposed to the plug-in).

My example was chosen for its large area of blue sky color, resulting in a

simple display of the selected pixels in the preview (see the active

selection in the original photo at right). As with the rest of the Asiva series,

Selection offers separate HSV adjustment panes so you can fine-tune the

area you are selecting, even to the degree of expanding the selection using

the Amount slider, as well as controlling the abrupt or gradual transition of

the selection with the Falloff slider.

As you work you can store your settings as Snapshots by Control-clicking

and recall them by clicking on one of the Snapshot Settings buttons. View

the current range of selected pixels with a color fill by choosing the

Overlay Color option (in this case, red).

Asiva technology is used extensively by the broadcast industry, by high-

end digital photographers, graphic artists and visual information specialists

in government, the military and medicine.

www.plugsandpixels.com/selection.html

http://www.plugsandpixels.com/selection.html


Tell your model she can eat as

much chocolate as she wants,

because Kodak’s brand new

Digital AIR plug-in is the best thing

for portraits since makeup itself!

Interestingly, while beta testing this
plug-in I tried applying it to a hand-
colored historical scenic photo
postcard that had uneven coloring,
tones and blotching. Digital GEM
Airbrush smoothed out the image and
made it look almost new while retaining
detail in the subject matter.
As you would expect for a new plug-in,

Digital GEM Airbrush supports
correction of 16-bit as well as 8-bit
images.

Kodak's Digital GEM Airbrush Pro

is the latest addition to their family

of image enhancing plug-ins. Its

main purpose is to quickly and efficiently provide

portrait-quality airbrushing repair by smoothing

imperfections in the surface of the image. You retain

complete control over the level of application of the

repair, with access to control sliders and a high

contrast close-up mask view of the changes made

during the correction.

The young model shown here had minor skin

blemishes not fully covered by her makeup, but it was

no problem at all for Digital GEM Airbrush to rectify.

Most importantly, the repair work is done immediately,

without the need for painstaking and time consuming

Stamp tool and airbrush work. Extreme and

unflattering highlights and shadows are brought under

control, and any wrinkles are removed without the

need for Botox treatments!

www.plugsandpixels.com/

digitalgempro.html

http://www.plugsandpixels.com/digitalgempro.html


Eye Candy 5: Textures packs

10 separate editable textures

into one new package, the first

of three recent upgrades that

comprise the EC 5 series (watch

for the new Exposure to be

released soon).

Textures is designed to create

16-bit seamless tiles such as

you'd incorporate into 3D work,

or you can create a single full-

frame background, complete

with depth and shading.

Textures includes 200 presets

to get your work started.
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www.plugsandpixels.com/
eyecandytextures.html

http://www.plugsandpixels.com/eyecandytextures.html


Created with:

ACD Canvas
Lucis Art

onOne PhotoFrame

Photos/artwork by: Mike Bedford

CLOSING ARTWORK

http://www.plugsnpixels.com/canvas.html
http://www.plugsnpixels.com/lucisart.html
http://www.plugsnpixels.com/photoframe.html
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